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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product Features

Overview
Figure 1-1  HP Compaq Pro 4300 All-in-One Business PC

The HP Compaq Pro 4300 All-in-One Business PC offers the following features:

● Integrated All-in-One form factor

● 20-inch diagonal widescreen 1600 x 900 WLED anti-glare display

● Adjustable tilt

● Removable panels on the back of the chassis allow users or technicians to easily and efficiently
service the PC

● Optional integrated 1.3 MP webcam & single non-array microphone

● Integrated stereo speakers
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● Choice of wired or wireless keyboard and mouse

● Windows® 7 Professional 32-bit or 64-bit operating system

● 6-in-1 media card reader

● 6 USB 2.0 ports

● Tray-load HP SuperMulti DVD+/-RW SATA Drive

● Up to 1 TB hard drive

● 2nd and 3rd generation Intel® Core™ processors

● Intel H61 Express Chipset

● Integrated Intel HD Graphics

● Integrated Gigabit network connection (Realtek RTL 8111 F Gigabit Ethernet)

● Up to 16 GB of DDR3 SDRAM memory

● Optional wireless LAN (802.11 a/g/n, 802.11 a/g/n with Bluetooth®)

● Face Recognition for HP ProtectTools software with auto-login capabilities (only with the optional
webcam)

● ENERGY STAR® qualified, EPEAT® Silver registered, and offers 89-percent energy-efficient
power
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Front Components
Figure 1-2  Front Components

Table 1-1  Front Components

Component Component

1 Webcam 4 Power button and LED

2 Single microphone 5 High-performance stereo speakers

3 20-inch diagonal 16:9 widescreen LED-backlit LCD
display
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Side Components
Figure 1-3  Side Components

Table 1-2  Side Components

Component Component

1 HP USB Media Card Reader 6 Optical disc drive activity LED

2 (2) USB 2.0 ports 7 Tray-load optical disc drive

3 Microphone jack 8 Brightness increase button

4 Headphone jack 9 Brightness decrease button

5 Optical disc drive eject button 10 Hard drive activity LED
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Rear Components
Figure 1-4  Rear Components

Table 1-3  Rear Components

Component Component

1 Drive access panel 7 Security lock slot

2 Center access panel 8 Power connector with LED indicator

3 Memory access panel 9 RJ-45 Gigabit Ethernet port

4 Optical disc drive location 10 Stereo audio line out

5 Hard drive location 11 (4) USB 2.0 ports

6 Memory and battery location 12 Serial port
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Adjusting Tilt
Tilt the computer forward up to -5 degrees or backward up to +25 degrees to set it to a comfortable
eye level.

Figure 1-5  Adjusting Tilt
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2 Installing and Customizing the
Software

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

NOTE: If the computer was shipped with Windows 7 loaded, you will be prompted to register the
computer with HP Total Care before installing the operating system. You will see a brief movie
followed by an online registration form. Fill out the form, click the Begin button, and follow the
instructions on the screen.

CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully installed. Doing so may cause errors and prevent the operating system from
installing properly.

NOTE: Be sure there is a 10.2-cm (4-inch) clearance at the back of the unit and above the monitor
to permit the required airflow.

Installing the Operating System
The first time you turn on the computer, the operating system is installed automatically. This process
takes about 5 to 10 minutes, depending on which operating system is being installed. Carefully read
and follow the instructions on the screen to complete the installation.

CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER
UNTIL THE PROCESS IS COMPLETE. Turning off the computer during the installation process may
damage the software that runs the computer or prevent its proper installation.

NOTE: If the computer shipped with more than one operating system language on the hard drive,
the installation process could take up to 60 minutes.

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

Downloading Microsoft Windows Updates
1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions on

the screen.

2. Once an Internet connection has been established, click the Start button.
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3. Select the All Programs menu.

4. Click on the Windows Update link.

In Windows 7, the Windows Update screen appears. Click view available updates and make
sure all critical updates are selected. Click the Install button and follow the instructions on the
screen.

It is recommended that you install all of the critical updates and service packs.

5. After the updates have been installed, Windows will prompt you to reboot the machine. Be sure
to save any files or documents that you may have open before rebooting. Then select Yes to
reboot the machine.

Installing or Upgrading Device Drivers (Windows
systems)

When installing optional hardware devices after the operating system installation is complete, you
must also install the drivers for each of the devices.

If prompted for the i386 directory, replace the path specification with C:\i386, or use the Browse
button in the dialog box to locate the i386 folder. This action points the operating system to the
appropriate drivers.

Obtain the latest support software, including support software for the operating system from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Accessing Disk Image (ISO) Files
There are disk image files (ISO files) included on your PC that contain the installation software for
additional software. These CD image files are located in the folder C:\SWSetup\ISOs. Each .iso file
can be burned to CD media to create an installation CD. It is recommended that these disks be
created and the software installed in order to get the most from your PC. The software and image file
names are:

● Corel WinDVD SD and BD – installation software for WinDVD – used to play DVD movies

● HP Insight Diagnostics OR Vision Diagnostics – software to perform diagnostic activities on your
PC

Protecting the Software
To protect the software from loss or damage, keep a backup copy of all system software,
applications, and related files stored on the hard drive. Refer to the operating system or backup utility
documentation for instructions on making backup copies of your data files.
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3 Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, memory,
audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash
media devices.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as
memory count, product name, and other non-error text messages. If a POST error occurs, the
error is displayed regardless of the mode selected. To manually switch to Post Messages
Enabled during POST, press any key (except F1 through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

● Secure integrated I/O functionality, including USB, audio, or embedded NIC, so that they cannot
be used until they are unsecured.

● Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

● Execute self-tests on a specified ATA hard drive (when supported by drive).

Computer Setup (F10) Utilities 9



Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Press Esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom
of the screen.

NOTE: If you do not press Esc at the appropriate time, you must restart the computer and
again press Esc when the monitor light turns green to access the utility.

3. Press F10 to enter Computer Setup.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

6. To apply and save changes, select File  > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings, select Apply Defaults and Exit. This option will restore the
original factory system defaults.

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.
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Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-1  Computer Setup—File

Option Description

System Information Lists:

● Product name

● SKU number (some models)

● Processor type/speed/stepping

● Cache size (L1/L2/L3)

● Installed memory size/speed, number of channels (single or dual) (if applicable)

● Integrated MAC address for embedded, enabled NIC (if applicable)

● System BIOS (includes family name and version)

● Chassis serial number

● Asset tag

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-2  Computer Setup—Storage

Option Description

Device Configuration Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

Hard Disk: Size, model, firmware, and serial number.

CD-ROM: Model, firmware, and serial number.

Diskette: Model. Only displays when a USB diskette drive is connected to the computer.

Storage Options SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating
system. There are two supported options: AHCI and IDE.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

IDE - This is the most backwards-compatible setting of the two options. Operating systems usually
do not require additional driver support in IDE mode.

NOTE: The AHCI device driver must be installed prior to attempting to boot from an AHCI
volume. If you attempt to boot from an AHCI volume without the required device driver installed,
the system will crash (blue screen).

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS
self-tests is attached to the system.

Boot Order Allows you to:

● Specify the order in which UEFI boot sources and legacy boot sources (such as a USB flash
media device, hard drive, optical drive, or network interface card) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or
included for consideration as a bootable operating system source.

● Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

Press F5 to disable a device. Press Enter to select a device. Press the arrow keys to drag a
selected device.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press F9 before the computer boots to the operating system. After POST is
completed, a list of bootable devices is displayed. Use the arrow keys to select the preferred
bootable device and press Enter. The computer then boots from the selected non-default device
for this one time.

12 Chapter 3   Computer Setup (F10) Utility



Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-3  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears
after a power cycle or reboot. If the user does not enter the correct power-on password, the unit
will not boot.

Device Security Allows you to set Device Available/Device Hidden for:

● System Audio

● Network Controller (some models)

● SATA0

● SATA1

USB Security Allows you to enable or disable groups of USB ports or individual USB ports. Default is device
available.

● Front USB Ports

◦ USB Port 9

◦ USB Port 10

● Rear USB Ports

◦ USB Port 2

◦ USB Port 3

◦ USB Port 4

◦ USB Port 5

● internal USB Ports

◦ USB Port 0

◦ USB Port 11

Slot Security Allows you to disable or enable the Mini Card slot. Default is enable.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
Express expansion card or embedded on the system board.) Default is enable.
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Table 3-3  Computer Setup—Security (continued)

System IDs Displays the following:

● Product name

● Serial number

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are
used to uniquely identify the system.)

● SKU number

● Family name

● Asset tag (18-byte identifier), a property identification number assigned by the company to
the computer.

● Feature byte

● Build ID

● Keyboard locale setting (for example, English or German)

System Security
(some models: these
options are hardware
dependent)

Data Execution Prevention (some models) (enable/disable) - Helps prevent operating system
security breaches. Default is enabled.

Virtualization Technology (VTx/VTd) (some models) (enable/disable) - Controls the virtualization
features of the processor and virtualization DMA remapping features of the chipset. Changing this
setting requires turning the computer off and then back on. Default is disabled.
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Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-4  Computer Setup—Power

Option Description

Hardware Power
Management

● SATA Power Management—Enables or disables the SATA bus and/or device power
management. Default is enabled.

● S4/S5 Wake On LAN—Wake on LAN (WOL) is normally used to turn on and shutdown
systems remotely. This option wakes the system from S4 (hibernate)/S5 (off) power state
when a Wake on LAN packet is received and follows normal boot order. Default is disabled.

Thermal Displays the system fan speed (RPMs).
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Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-5  Computer Setup—Advanced

Option Heading

Power-On Options Allows you to set:

● POST messages (enable/disable). Suppresses most POST messages, such as memory
count, product name, and other non-error text messages. If a POST error occurs, the error is
displayed regardless of the mode selected.

● After Power Loss (off/on/previous state): Setting this option to:

◦ Off—causes the computer to remain powered off when power is restored.

◦ On—causes the computer to power on automatically as soon as power is restored.

◦ Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

● POST Delay (None, 5, 10 15, 20, or 60 seconds). Enabling this feature will add a user-
specified delay to the POST process. This delay is sometimes needed for hard disks on
some PCI cards that spin up very slowly, so slowly that they are not ready to boot by the time
POST is finished. The POST delay also gives you more time to select F10 to enter Computer
(F10) Setup.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable Legacy devices.

Bus Options On some models, allows you to enable or disable:

● PCI SERR# Generation. Default is enable.

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disable.

Device Options Allows you to set:

● Num Lock State at Power-On (off/on). Default is on.

● Multi-Processor (enable/disable). Use this option to disable multi-processor support under
the OS. Default is enabled.

● Hyper-threading (Enable/disable). Provides processor parallelization such that the operating
system treats one processor as two. Default is enable.

● NIC Option ROM Download (enable/disable). The BIOS contains an embedded NIC option
ROM to allow the unit to boot through the network to a PXE server. This is typically used to
download a corporate image to a hard drive. The NIC option ROM takes up memory space
below 1 MB commonly referred to as DOS Compatibility Hole (DCH) space. This space is
limited. This F10 option will allow users to disable the downloading of this embedded NIC
option ROM thus giving more DCH space for additional PCI cards which may need option
ROM space. Default is-enable.

● Processor Frequency Multiplier. Accessible using CTRL+A. The frequency multiplier adapts
the external frequency of the computer to the internal frequency of the processor. This
setting lets you overclock your computer.
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4 Serial ATA (SATA) Drive Guidelines
and Features

NOTE: HP only supports the use of SATA hard drives on these models of computer. No Parallel
ATA (PATA) drives are supported.

SATA Hard Drives

Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA Hard Drive Cables

SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and
never bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.
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SMART ATA Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities
The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may
be properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the
operating system may differ from that marked on the hard drive or listed in the computer specification.
Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

 Maximum Size

File System Controller Type Operating System Partition Drive

FAT 32 ATA Windows 7 32 GB 2 TB

NTFS ATA Windows 7 2 TB 2 TB
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5 Routine Care and Disassembly
Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage. 
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Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

Generating Static

The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs* from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V

Removing DIPs* from vinyl tray

Removing DIPs* from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

*These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to prevent
damage to electric components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.
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● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on
both feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000

Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors
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● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and
cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all
vented sides of the computer and above the monitor to permit the required airflow.

● Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

● Never operate the computer with the cover removed.

● Do not place computers so near each other that they are subject to each other’s re-circulated or
preheated air.

● Keep liquids away from the computer and keyboard.

● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software,
including sleep states.
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Routine Care

General Cleaning Safety Precautions

1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General Cleaning Safety Precautions on page 23 before cleaning the
computer.

To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the Keyboard

Follow all safety precautions in General Cleaning Safety Precautions on page 23 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 23.

When cleaning debris from under the keys, review all rules in General Cleaning Safety Precautions
on page 23 before following these procedures:

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys. 

● Visible debris underneath or between the keys may be removed by vacuuming or shaking.

● Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.
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● If you remove a key, use a specially designed key puller to prevent damage to the keys. This
tool is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

● Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor

● Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

● To clean the monitor body follow the procedures in Cleaning the Computer Case on page 23.

Cleaning the Mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 23.

Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Tools and Software Requirements

To service the computer, you need the following:

● Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

● Diagnostics software

● HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

24 Chapter 5   Routine Care and Disassembly Preparation



Cables and Connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot
be caught or snagged by parts being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer. 

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

● Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Electrostatic Discharge Information on page 20

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

Lithium Coin Cell Battery

The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose
in water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the
battery.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.
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6 Removal and Replacement Procedures
All-in One (AIO) Chassis

The following sections provide information about disassembling various components of the computer.

Preparing to Disassemble the Computer
To avoid injury and equipment damage, always complete the following steps in order, when opening
the HP Pro All-in-One.

1. Remove all media (CD, DVD, etc.) from the computer.

2. Shut down the computer.

3. After the system has completely shut down, disconnect the power adapter from the back of the
computer.

4. Disconnect all other attached cables from the back of the computer.

5. Place the computer face down on a soft flat surface. HP recommends that you set down a
blanket, towel, or other soft cloth to protect the screen surface from scratches or other damage.

WARNING! Beware of sharp edges inside the chassis.
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Hinge Cover Panel
The hinge cover panel is located above the stand. You must remove it to remove the drive access
panel and memory access panel.

Figure 6-1  Hinge cover panel location

To remove the hinge cover panel:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).
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2. Remove the hinge cover panel by pulling outward on the panel at the slot on the top edge of the
panel.

Figure 6-2  Removing the hinge cover panel

To replace the hinge cover panel, reverse the removal procedures.
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Memory Access Panel
The memory access panel is located on the rear, right side of the computer (viewed from behind).
You must remove it to access the memory modules and RTC battery.

Figure 6-3  Memory access panel location

To remove the memory access panel:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).
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3. Open the latch securing the memory access panel.

Figure 6-4  Opening the memory access panel latch

4. To remove the memory access panel, press down on the tab on the inside edge of the panel (1)
and slide the panel off the computer (2).

Figure 6-5  Removing the memory access panel

To replace the memory access panel, reverse the removal procedures.
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Drive Access Panel
The drive access panel is located on the rear, left side of the computer (viewed from behind). You
must remove it to access the hard drive and optical drive.

Figure 6-6  Drive access panel location

To remove the drive access panel:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).
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3. Open the latch securing the drive access panel.

Figure 6-7  Opening the drive access panel latch

4. To remove the drive access panel, push downward on the tab on the inside edge of the panel (1)
and slide the panel off the computer (2).

Figure 6-8  Removing the drive access panel

To replace the drive access panel, reverse the removal procedures.
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Optical Drive
The optical drive is located under the drive access panel on the left side of the computer (viewed from
behind). It is secured with one Torx screw.

Figure 6-9  Optical drive location

To remove the optical drive:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the drive access panel (see Drive Access Panel on page 31).

4. Remove the screw through the tab on the end of the drive that secures the drive to the
computer.

Figure 6-10  Removing the optical disc drive security screw
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5. Using your fingers, press the visible edge of the optical disc drive toward the side of the
computer to push the drive partially out of the computer. Grasp the front end of the drive and pull
the drive out of the computer.

Figure 6-11  Removing the optical disc drive

6. If you need to remove the drive bracket from the drive, remove the two screws (1) that secure
the bracket to the drive, and then remove the bracket from the drive (2).

NOTE: Optical drive spare part kits do not include replacement brackets.

Figure 6-12  Removing the optical drive bracket

To install an optical drive, reverse the removal procedures.
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Hard Drive
The hard drive is located under the drive access panel on the left side of the computer (viewed from
behind). The drive is secured with one captive Torx screw and is housed in a removable cage.

Figure 6-13  Hard drive location

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the drive access panel (see Drive Access Panel on page 31).

4. Loosen the captive screw next to the front of the drive that secures the drive to the computer.

Figure 6-14  Loosening the hard drive security screw
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5. Grasp the handle on top of the hard drive cage (1) and slide the cage toward the outer edge of
the computer, then lift the cage out of the computer (2).

Figure 6-15  Removing the hard drive cage

6. Remove the four mounting screws that secure the drive to the cage. Do not remove the blue
rubber grommets behind each screw. They must stay attached to the cage when installing a new
hard drive.

Figure 6-16  Removing the hard drive mounting screws
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7. Slide the hard drive out of the cage.

Figure 6-17  Removing the hard drive from the cage

To replace the hard drive, reverse the removal procedures.

NOTE: If you choose to install an optional 2.5-inch solid state drive (SSD) or self-encrypting drive
(SED), you must mount that drive in a drive adapter, and then install the assembly in the hard drive
cage as you would a 3.5-inch hard drive.
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Memory
Memory modules are located on the right side of the computer (viewed from behind) under the
memory access panel. The computer has two memory slots.

Figure 6-18  Memory module location

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) small outline dual inline memory modules (SODIMMs).

The memory sockets on the system board can be populated with up to two industry-standard
SODIMMs. These memory sockets are populated with at least one preinstalled SODIMM. To achieve
the maximum memory support, you can populate the system board with up to 16 GB of memory.

For proper system operation, the SODIMMs must be:

● industry-standard 204-pin

● unbuffered non-ECC PC3-10600 DDR3-1600 MHz-compliant

● 1.5 volt DDR3-SDRAM SODIMMs

The DDR3-SDRAM SODIMMs must also:

● support CAS latency 9 DDR3 1600 MHz (9-9-9 timing)

● contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided SODIMMS

● SODIMMs constructed with x8 and x16 devices; SODIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported SODIMMs.
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The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the SODIMMs are installed. Refer to the following table to identify the SODIMM
channel locations.

Table 6-1  Identifying SODIMM locations

Location System Board Label Channel

Lower Socket DIMM0 Channel B

Upper Socket DIMM0 Channel A

● The system will operate in single channel mode if the SODIMM sockets are populated in one
channel only.

● The system will operate in a higher-performing dual channel mode if the memory capacity of the
SODIMM in Channel A is equal to the memory capacity of the SODIMM in Channel B.

● The system will operate in flex mode if the memory capacity of the SODIMM in Channel A is not
equal to the memory capacity of the SODIMM in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual
channel and the remainder is assigned to single channel. If one channel will have more memory
than the other, the larger amount should be assigned to channel A.

● In any mode, the maximum operational speed is determined by the slowest SODIMM in the
system.

There are two memory sockets on the system board located behind the memory access panel. To
remove or install memory modules:

To remove a memory module:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Place the computer face down on a soft flat surface. HP recommends that you set down a
blanket, towel, or other soft cloth to protect the screen surface from scratches or other damage.

3. Remove the center access panel (see Hinge Cover Panel on page 27).

4. Remove the memory access panel (see Memory Access Panel on page 29).
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5. Pull upward on the raised tab on the memory cover and lift the cover off the computer.

Figure 6-19  Removing the memory cover

6. To remove a memory module, press outward on the two latches on each side of the SODIMM
(1), then pull the SODIMM out of the socket (2).

Figure 6-20  Removing a memory module
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7. To install a memory module, slide the SODIMM into the socket at approximately a 30° angle (1),
then press the SODIMM down (2) so that the latches lock it in place (3).

Figure 6-21  Installing a memory module

NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

8. Press the memory cover back in place. Insert the bottom edge of the memory cover into the
sheet metal shielding first, then press the top edge of memory cover down. Ensure that all the
tabs on the memory cover are pressed firmly against the sheet metal shielding.

Figure 6-22  Replacing the memory cover

The computer automatically recognizes the additional memory when you turn on the computer.
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Replacing the Battery
The RTC battery is located near the memory modules under the memory access panel.

Figure 6-23  Battery location

The battery is located in the memory compartment. The battery that comes with the computer
provides power to the real-time clock. When replacing the battery, use a battery equivalent to the
battery originally installed in the computer. The computer comes with a 3-volt lithium coin cell battery.

WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60° C (140º F).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object.
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NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Pull upward on the raised tab on the memory cover and lift the cover off the computer.

Figure 6-24  Removing the memory cover

5. Depending on the type of battery holder on the system board, complete the following instructions
to replace the battery.

Type 1

a. Lift the battery out of its holder.

Figure 6-25  Removing a coin cell battery (Type 1)

b. Slide the replacement battery into position, positive side up. The battery holder
automatically secures the battery in the proper position.
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Type 2

a. To release the battery from its holder, squeeze the metal clamp that extends above one
edge of the battery. When the battery pops up, lift it out (1).

b. To insert the new battery, slide one edge of the replacement battery under the holder’s lip
with the positive side up. Push the other edge down until the clamp snaps over the other
edge of the battery (2).

Figure 6-26  Removing and replacing a coin cell battery (Type 2)

Type 3

a. Pull back on the clip (1) that is holding the battery in place, and remove the battery (2).

b. Insert the new battery and position the clip back into place.

Figure 6-27  Removing a coin cell battery (Type 3)
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Heat Sink Cover
The heat sink cover protects the heat sink and system board. It is secured with five Torx screws.

Figure 6-28  Heat sink cover location

To remove the heat sink cover:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the five black Torx screws that secure the cover to the computer.

Figure 6-29  Heat sink cover screws
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5. Lift the cover from the computer.

Figure 6-30  Removing the heat sink cover

To install the heat sink cover, reverse the removal procedures.

When installing the cover, be sure to insert the tabs from the cover into the slots in the computer.

Figure 6-31  installing the heat sink cover
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Heat Sink (Thermal Module)
The heat sink is secured with five Torx screws – four captured, one not captured.

Figure 6-32  Heat sink location

To remove the heat sink:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the heat sink cover (see Heat Sink Cover on page 45).

7. Loosen the four silver captive Torx screws on the heat sink (1).

CAUTION: Remove heat sink retaining screws in diagonally opposite pairs (as in an X) to even
the downward forces on the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.
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8. Remove the black Torx screw from the top of the heat sink (2).

Figure 6-33  Loosening and removing the heat sink screws

9. Lift the heat sink from the computer.

Figure 6-34  Removing the heat sink

CAUTION: To reduce a degradation in thermal performance, be sure not to touch the thermal
grease on the surface of the processor or the heat sink.

To replace the heat sink, reverse the removal procedures.
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Processor
1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer

on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the heat sink cover (see Heat Sink Cover on page 45).

6. Remove the heat sink (see Heat Sink (Thermal Module) on page 47).

7. Rotate the locking lever to its full open position (1).

8. Raise and rotate the microprocessor retainer to its fully open position (2).

9. Carefully lift the processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

Figure 6-35  Removing the processor

To install a new processor:

1. Place the processor in its socket and close the retainer. Make sure the slot in the processor fits
into the post on the socket.

2. Secure the locking lever. If reusing the existing heat sink, go to step 3. If using a new heat sink,
go to step 6.
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3. If reusing the existing fan sink, clean the bottom of the fan sink with the alcohol pad provided in
the spares kit.

CAUTION: Before reinstalling the fan sink you must clean the top of the processor and the
bottom of the fan sink with an alcohol pad supplied in the spares kit. After the alcohol has
evaporated, apply thermal grease to the top of the processor from the syringe supplied in the
spares kit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the fan
sink atop the processor.

5. Go to step 7.

6. If using a new fan sink, remove the protective covering from the bottom of the fan sink and place
it in position atop the processor.

7. Secure the fan sink to the system board and system board tray.

CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an
X) to evenly seat the fan sink on the processor. This is especially important as the pins on the
socket are very fragile and any damage to them may require replacing the system board.

NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.
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Top Panel
The top panel is secured with two Torx screws. Removing it allows access to the webcam and allows
you to remove the main rear cover.

Figure 6-36  Top panel location

To remove the top panel:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. On the top of the computer, remove the two black Torx screws (1) that secure the top panel to
the computer.

6. Rotate the top of the panel outward (2), and then lift the panel off the computer.

Figure 6-37  Removing the top panel

To replace the top panel, reverse the removal procedures.
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Webcam Module
The webcam module is located at the top of the computer beneath the top panel. It is secured with
two silver Phillips screws and has one connector.

Figure 6-38  Webcam module location

To remove the webcam module:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the top panel (see Top Panel on page 51).
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6. Remove the two silver Phillips screws that secure the webcam module to the computer.

Figure 6-39  Webcam module screws

7. As far as the cable allows, remove the webcam module from the computer, and then disconnect
the cable from the module.

Figure 6-40  Disconnecting the webcam module

To install a webcam module, reverse the removal procedures.
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Stand
The stand is secured with three Torx screws. You must remove the center access panel to remove
the stand.

To remove the stand:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the three silver Torx screws (1) that secure the stand to the computer.

4. Lift the memory and drive access panel latches (2).

5. Slide the stand toward the top of the computer slightly (3), and then lift the stand off the
computer (4).

Figure 6-41  Removing the stand

To replace the stand, reverse the removal procedures.
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Rear Cover
The rear cover is secured with four Torx screws. The optical drive security screw also secures the
rear cover. After removing the screws, you must pry it off at the seams around the edges of the
computer.

To remove the rear cover:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the optical drive (see Optical Drive on page 33).

7. Remove the top panel (see Top Panel on page 51).

8. Remove the five black Torx screws that secure the rear panel to the computer (1).

9. Pry the cover off the computer by pulling the top edge (2) loose, then prying the side loose near
the memory modules (3), bottom side (4), and left side (5).

NOTE: The cover may be very tight and difficult to remove.

Figure 6-42  Removing the rear cover

10. Remove the rear cover from the computer.

To replace the rear cover, reverse the removal procedures.
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Fan
The fan is located near the middle of the computer under the main rear cover. The fan is secured with
three Torx screws. You do not have to remove the heat sink to remove the fan.

Figure 6-43  Fan assembly location

To remove the fan assembly:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the optical drive (see Optical Drive on page 33).

7. Remove the heat sink cover (see Heat Sink Cover on page 45).

8. Remove the top panel (see Top Panel on page 51).

9. Remove the rear cover (see Rear Cover on page 55).
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10. Remove the three black Torx screws that secure the fan to the computer, and then disconnect
the fan cable from the system board connector labeled CHASSIS_FAN1.

Figure 6-44  Fan screws

11. Slide the fan toward the right to remove it from underneath the metal bracket, and then lift the
fan from the computer.

Figure 6-45  Removing the fan

To install the fan assembly, reverse the removal procedures.
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Converter Board
The converter board is located on the left side of the computer (viewed from behind) under the main
rear cover. It is secured with two Torx screws and has two connectors.

Figure 6-46  Converter board location

To remove the converter board:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the optical drive (see Optical Drive on page 33).

7. Remove the top panel (see Top Panel on page 51).

8. Remove the rear cover (see Rear Cover on page 55).

9. Disconnect the two cables from the board (1).

NOTE: Be careful not to damage the cables when disconnecting them from the board. Do not
pull on the wires.

10. Remove the two silver Torx screws (2) that secure the board to the computer.
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11. Lift the converter board from the computer.

Figure 6-47  Removing the converter board

Be sure to correctly position the jumpers on the converter board for the installed display panel,
as follows:

CAUTION: Incorrect jumper placement can result in damage to the converter board.

● LG panel: pins (1)(2) & (3)(4)

● Samsung panel: pins (3)(4) & (5)(6)

● CMI panel: pins (1)(2) & (5)(6)

LG Samsung

CMI  

To install the converter board, reverse the removal procedures.
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Sidekey Board
The sidekey board is located on the bottom left side of the computer (viewed from behind) under the
main rear cover. It is secured with two Torx screws and has one connector.

The associated cable connects to the front power switch assembly. To remove this cable, you must
remove the stand bracket, disassembly of which is shown later in this document at Stand bracket
on page 68.

Figure 6-48  Sidekey board location

To remove the sidekey board:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the optical drive (see Optical Drive on page 33).

7. Remove the top panel (see Top Panel on page 51).

8. Remove the rear cover (see Rear Cover on page 55).
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9. Disconnect the cable from the sidekey board.

NOTE: Be careful not to damage the cable when disconnecting it from the board. Do not pull
on the wires.

Figure 6-49  Disconnecting the sidekey board cable

10. Remove the two silver Torx screws that secure the board to the computer.

Figure 6-50  Sidekey board screws
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11. Rotate the bottom of the board upward, and then remove the board from the computer.

Figure 6-51  Removing the sidekey board

To install the sidekey board, reverse the removal procedures.

System Board Shield
The system board shield covers the bottom of the system board. It is secured with two Torx screws
and two hex screws around the serial port.

Figure 6-52  System board shield location
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To remove the system board shield:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the optical drive (see Optical Drive on page 33).

7. Remove the top panel (see Top Panel on page 51).

8. Remove the heat sink cover (see Heat Sink Cover on page 45).

9. Remove the rear cover (see Rear Cover on page 55).

10. Remove the two black Torx screws (1) that secure the shield to the computer.

NOTE: The Torx screw in the lower left also secures the stand bracket.

11. Remove the two silver hex screws around the serial port (2).

12. Lift the shield from the computer.

Figure 6-53  Removing the system board shield

To install the system board shield, reverse the removal procedures.
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WLAN Module
The WLAN module is located on the bottom left of the system board. The module is secured with one
Phillips screw and has two connected antennas.

Figure 6-54  WLAN module location

To remove the WLAN module:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the optical drive (see Optical Drive on page 33).

7. Remove the top panel (see Top Panel on page 51).

8. Remove the rear cover (see Rear Cover on page 55).

9. Remove the heat sink cover (see Heat Sink Cover on page 45).

10. Remove the system board shield (see System Board Shield on page 62).
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11. Disconnect the antenna cables from the module (1).

12. Remove the Phillips screw (2) that secures the module to the computer.

Figure 6-55  Removing the WLAN module screw and antennas

13. Lift the module to a 45-degree angle, and then pull it away to remove it from the socket.

Figure 6-56  Removing the WLAN module

To install the WLAN module, reverse the removal procedures.

NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.
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Speakers
The speakers are located at the bottom of the computer. Two separate speakers are each secured by
two Torx screws and have separate cables and system board connectors.

Figure 6-57  Speaker location

To remove the speakers:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the optical drive (see Optical Drive on page 33).

7. Remove the heat sink cover (see Heat Sink Cover on page 45).

8. Remove the top panel (see Top Panel on page 51).

9. Remove the rear cover (see Rear Cover on page 55).

10. Remove the system board shield (see System Board Shield on page 62).

11. Remove two Torx screws that secure each speaker to the computer.

12. Disconnect the speaker cables from the system board connectors . The left speaker connects to
the white connector labeled LFT_SPKR. The right speaker connects to the black connector
labeled RT_SPKR.
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13. Remove the speakers from the computer.

Figure 6-58  Removing the speakers

To install the speakers, reverse the removal procedures.
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Stand bracket
The stand bracket is located near the middle of the computer, below the fan. Remove the bracket to
gain access to the drive cables and sidekey board cable assembly. The bracket is secured with four
Torx screws.

Figure 6-59  Stand bracket location

To remove the stand bracket:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the optical drive (see Optical Drive on page 33).

7. Remove the top panel (see Top Panel on page 51).

8. Remove the rear cover (see Rear Cover on page 55).
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9. Remove the four black Torx screws that secure the stand bracket to the computer.

NOTE: The bottom right corner of the stand bracket shares a screw with the system board
cover. If you have not removed the system board cover prior to removing the stand bracket, you
will need to remove this screw to remove the stand bracket.

Figure 6-60  Stand bracket screw locations

10. Lift the bracket from the computer.

Figure 6-61  Removing the stand bracket

To install the stand bracket, reverse the removal procedures.

NOTE: When reinstalling the stand bracket, be sure to insert the right side of the bracket
underneath the system board cover.
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System Board
The system board is located on the right side of the computer (viewed from the rear) under the heat
sink and system board covers. It is secured with eight Torx screws.

Figure 6-62  System board location

To remove the system board:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the memory modules (see Memory on page 38).

5. Remove the drive access panel (see Drive Access Panel on page 31).

6. Remove the stand (see Stand on page 54).

7. Remove the optical drive (see Optical Drive on page 33).

8. Remove the heat sink cover (see Heat Sink Cover on page 45).

9. Remove the thermal module/heat sink (see Heat Sink (Thermal Module) on page 47).

10. Remove the top panel (see Top Panel on page 51).

11. Remove the rear cover (see Rear Cover on page 55).

12. Remove the system board cover (see System Board Shield on page 62).

13. Remove the WLAN module (see WLAN Module on page 64).

14. Remove the processor (see Processor on page 49).

15. Disconnect all cables from the system board, noting their location for reinstallation.
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16. Remove the eight silver Torx screws (circled in image) that secure the system board to the
computer.

Figure 6-63  System board screw locations

17. Lift the system board straight up and out of the computer.

NOTE: The thermal material on the bottom of the system board may cause it to stick to the
computer.

NOTE: Before returning the defective system board, remove the CPU cover from the replacement
system board and install it on the defective system board.

To install the system board, reverse the removal procedures.

Updating SMBIOS Information

When replacing the system board, you must reprogram the SMBIOS information on the affected
computer. Failure to reprogram the board will result in eventual failure, such as an activation failure
(need to reactivate the system) or a system recovery failure.

To update SMBIOS information in Computer Setup:

1. Turn on or restart the computer.

2. Press Esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom
of the screen.

NOTE: If you do not press Esc at the appropriate time, you must restart the computer and
again press Esc when the monitor light turns green to access the utility.
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3. Press F10 to enter Computer Setup.

4. Go to Security > System ID’s.

5. If necessary, press Ctrl+A to initiate edit mode.

6. Edit the fields listed. If the feature byte has data or is not editable, then it was not cleared and
cannot be edited.

System ID Setup Page

Setup Field Name Comment Label

Product Name Enter the Model name/number or marketing name. Flexbuild

Serial Number Enter the Serial Number of Unit. Support

SKU Number Enter the SKU or Product Number including Localization Code. Support

Asset Tag Enter the 18-byte identifier assigned to the computer. Support

Feature Byte Enter the Feature Byte string. The feature byte string is case dependent.

The label includes spaces after every four characters. You can enter or
ignore these spaces – their only purpose is to help with data entry. There is
a character limitation of 40 bytes per line. When you reach this limit, go to
the next line to continue data entry. BIOS ignores the spaces and lines.

If you make an error during data entry, the data will not validate, and the
computer asks you to correct your data input.

Flexbuild

Build ID The Build ID of the unit. Flexbuild
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Hard Drive and Optical Drive Cables and Connectors
The hard drive and optical drive connectors are located near the middle of the computer, partially
under the bracket that secures the stand. Each connector is secured with two Torx screws and has
two cables that connect to the system board.

The optical drive connector cables are longer than the hard drive connector cables.

Figure 6-64  Hard drive cable and optical drive cable location

To remove the hard drive or optical drive connector:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the hard drive (see Hard Drive on page 35).

7. Remove the optical drive (see Optical Drive on page 33).

8. Remove the top panel (see Top Panel on page 51).

9. Remove the rear cover (see Rear Cover on page 55).

10. Remove the system board cover (see Heat Sink Cover on page 45).

11. Remove the stand bracket (see Stand bracket on page 68).

12. Remove two Torx screws that secure the hard drive connector (1) or the optical drive connector
(2) to the computer.

13. Remove the cables from the metal clips (3) built into the computer.
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14. Disconnect the hard drive cables (4) or the optical drive cables (5) from the system board.

NOTE: Be careful not to damage the cable when disconnecting it from the board. Do not pull
on the wires.

15. Remove the connector from the computer.

Figure 6-65  Removing the hard drive or optical drive connectors

To install the hard drive or optical drive connector, reverse the removal procedures.
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Display Cable
The main display cable connector is located behind the system board. You must remove the system
board to remove the display cable.

Figure 6-66  Display cable location

To remove the display cable:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the optical drive (see Optical Drive on page 33).

7. Remove the heat sink cover (see Heat Sink Cover on page 45).

8. Remove the heat sink (see Heat Sink (Thermal Module) on page 47.

9. Remove the top panel (see Top Panel on page 51).

10. Remove the rear cover (see Rear Cover on page 55).

11. Remove the system board shield (see System Board Shield on page 62).

12. Remove the system board (see System Board on page 70).
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13. Disconnect the cable from the display panel by pressing in the latches on the side of the cable
(1) and pulling it from the connector (2).

Figure 6-67  Removing the display cable

To install the display cable, reverse the removal procedures.
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Front Bezel
The front bezel is located on the front of the computer and is secured to the main system bracket with
five Torx screws and nine tabs.

You can remove the front bezel without disassembling many of the computer's components. Most
components can remain attached to the base pan. The following procedure demonstrates removing
the bezel while removing the smallest number of components possible.

To remove the front bezel:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the top panel (see Top Panel on page 51).

6. Remove the rear cover (see Rear Cover on page 55).

7. Remove the speakers (see Speakers on page 66).

8. Remove the power switch assembly cable from the front bezel. You do not have to remove the
remaining cables.

9. Remove the five black Torx screws that secure the bezel to the main system bracket assembly.

10. Lift the nine tabs (see arrows in image) that secure the bezel to the main system bracket
assembly. Be sure to slide the bracket free from the tabs as you lift each one.
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11. Lift the main system bracket assembly off the front bezel.

Figure 6-68  Removing the front bezel assembly from the computer

12. Lift the main display panel assembly from the front bezel.

To install the front bezel, reverse the removal procedures.

Display Panel
If you disconnect the display cable from the display panel, you do not have to remove the system
board to replace the display panel.

Three different display panels are available – LG, Samsung, and CMI.

Display panels require a backlight cable specific to the manufacturer. Make sure you use the
backlight cable packaged with the display panel.

The display panel is secured to the base pan with four Torx screws, as follows:

● CMI - two screws on top, two screws on the bottom

● LG and Samsung - two screws on each side but in different locations

To remove the display panel:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).
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6. Remove the top panel (see Top Panel on page 51).

7. Remove the rear cover (see Rear Cover on page 55).

8. Remove the power switch assembly from the front bezel (see Power Switch Assembly
on page 82).

NOTE: After you remove the power switch assembly with LED and cable from the front bezel,
you do not have to remove the side key cable.

9. Remove the front bezel (see Front Bezel on page 77).

10. Disconnect the display cable from the display panel (1).

NOTE: Replace the backlight cable (2) with the new backlight cable that comes with the new
display panel kit.

Remove the backlight cable from the defective panel before sending the panel back to the
supplier.

Figure 6-69  Removing the display cable from the display panel
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11. Remove the four silver Torx screws that secure the display panel to the frame. The screw
locations for each manufacturer are stamped into the metal.

The LG (1) and Samsung (2) panels are secured with two screws on each side (left and right).

Figure 6-70  Display panel screw locations – LG or Samsung panels

The CMI panel is secured with two screws on top, two screws on the bottom.

Figure 6-71  Display panel screw locations – CMI panel

12. Lift the display panel from the frame.

13. Be sure to correctly position the jumpers on the converter board for the installed display panel,
as follows:

CAUTION: Incorrect jumper placement can result in damage to the converter board and LCD
panel.

● LG panel: pins (1)(2) & (3)(4)

● Samsung panel: pins (3)(4) & (5)(6)

● CMI panel: pins (1)(2) & (5)(6)
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LG  

Samsung CMI

To install a display panel, reverse the removal procedures.
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Power Switch Assembly
The power switch assembly is located on the bottom corner of the inside of the front bezel. You must
remove the front bezel from the computer to remove the power switch assembly from the bezel.

Figure 6-72  Power switch assembly location

To remove the power switch assembly:

1. Prepare the computer for disassembly (see Preparing to Disassemble the Computer
on page 26).

2. Remove the center access panel (see Hinge Cover Panel on page 27).

3. Remove the memory access panel (see Memory Access Panel on page 29).

4. Remove the drive access panel (see Drive Access Panel on page 31).

5. Remove the stand (see Stand on page 54).

6. Remove the optical drive (see Optical Drive on page 33).

7. Remove the top panel (see Top Panel on page 51).

8. Remove the rear cover (see Rear Cover on page 55).

9. Remove the front bezel (see Front Bezel on page 77.

10. Pull the two tabs (1) toward the bottom of the bezel, and then rotate the assembly up and off the
bezel (2).

11. Pull the light pipe out of its slot (3).
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12. Remove the cable from the clip built into the bezel (4), and then remove the power switch
assembly from the front bezel.

Figure 6-73  Removing the power switch assembly

To install the power switch assembly, reverse the removal procedures.
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7 Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as diskette
drive, hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter
problems with the computer, refer to the tables in this chapter for probable causes and recommended
solutions.

NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messages on page 113.

Safety and Comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.
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Solving General Problems
You may be able to easily resolve the general problems described in this section. If a problem
persists and you are unable to resolve it yourself or if you feel uncomfortable about performing the
operation, contact an authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table 7-1  Solving General Problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four
seconds until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to USB keyboard or mouse.

Cause Solution

Computer is in standby mode. To resume from standby mode, press the power button or
press any key.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

First, reset the date and time under Control Panel
(Computer Setup can also be used to update the RTC date
and time). If the problem persists, replace the RTC battery.
See the Removal and Replacement section for instructions
on installing a new battery, or contact an authorized dealer or
reseller for RTC battery replacement.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.
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There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the F10 BIOS settings to make sure the internal
system speaker is not muted (this setting does not
affect the external speakers).

2. Make sure the external speakers are properly
connected and powered on and that the speakers'
volume control is set correctly.

3. Use the system volume control available in the
operating system to make sure the speakers are not
muted or to increase the volume.

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved
memory back to the system.

Restart the computer.

Virus resident on the hard drive. Run virus protection program.

Too many applications running. 1. Close unnecessary applications to free up memory.

2. Add more memory. Some applications run in the
background and can be closed by right-clicking on their
corresponding icons in the task tray. To prevent these
applications from launching at startup, go to Start > All
Programs > Accessories > Run and type msconfig.
On the Startup tab of the System Configuration Utility,
clear applications that you do not want to launch
automatically.

Some software applications, especially games, are stressful
on the graphics subsystem

1. Lower the display resolution for the current application
or consult the documentation that came with the
application for suggestions on how to improve
performance by adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.
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Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the
processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
board header.

3. If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

1. Check that the voltage selector, located on the rear of
the power supply on some models, is set to the
appropriate voltage. Proper voltage setting depends on
your region.

2. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If
the hard drive LED does not turn on green then:

1. Check that the unit is plugged into a working AC outlet.

2. Open computer and check that the power button board
cable is properly connected to the system board.

3. Check that power supply cables are properly connected
to the system board.

4. Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button board.

5. If the 5V_aux light on the system board is off, then
replace the power supply.

6. Replace the system board.
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Solving Power Problems
Common causes and solutions for power problems are listed in the following table.

Table 7-2  Solving Power Problems

Computer powered off automatically and the Power LED flashes red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the
processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
board header.

3. If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.

Power LED flashes red four times, once every second, followed by a two second pause, and the computer beeps
four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1. Check if a device is causing the problem by removing
ALL attached devices (such as hard, diskette, or optical
drives, and expansion cards). Power on the system. If
the system enters the POST, then power off and
replace one device at a time and repeat this procedure
until failure occurs. Replace the device that is causing
the failure. Continue adding devices one at a time to
ensure all devices are functioning properly.

2. Replace the power supply.

3. Replace the system board.

Solving Hard Drive Problems

Table 7-3  Solving Hard Drive Problems

Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. Right-click Start, click Explore, and right-click on a
drive. Select Properties then select the Tools tab.
Under Error-checking click Check Now.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.
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Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with
a file.

Right-click Start, click Explore, and right-click on a drive.
Select Properties then select the Tools tab. Under Error-
checking click Check Now.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 101 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

Nonsystem disk/NTLDR missing message.

Cause Solution

The system is trying to start from a diskette that is not
bootable.

Remove the diskette from the diskette drive.

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using fdisk: If NTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

System files missing or not properly installed. 1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using Fdisk: If NFTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive
entry in the Storage > Boot Order list.
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Table 7-3  Solving Hard Drive Problems (continued)

Nonsystem disk/NTLDR missing message.

Cause Solution

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached
to the system board dark blue SATA connector.

Bootable hard drive's controller is not listed first in the Boot
Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive's controller is
listed immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error
Messages on page 113 to determine possible causes for the
blinking red and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.

Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to turn
off the power. To restart the computer, press the power
button again.

The removable hard drive is not recognized by the computer.

Cause Solution

The removable hard drive carrier is not fully seated in the
enclosure frame or the hard drive is not fully seated in the
carrier.

Push the carrier into the enclosure frame so that the
connector on the rear of the frame is properly seated. If this
does not solve the problem, turn off the computer, remove
the carrier, and check to see if the connector on the hard
drive is properly seated in the carrier.
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The removable hard drive enclosure is beeping and the green LED is flashing.

Cause Solution

Fan failure alarm on the removable hard drive enclosure has
been activated.

Shut down the computer and contact HP for a replacement
enclosure.
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Solving Media Card Reader Problems

Table 7-4  Solving Media Card Reader Problems

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your
card to see if it writable. Refer to the previous section for a
list of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold
contact on the correct side. The green LED will light if
inserted properly.

Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. Open Computer, right-click on the corresponding drive icon,
and select Eject. Then pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized
by the computer.

Cause Solution

The operating system needs time to recognize the device if
the reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize whatever media is inserted in the reader.
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After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from the
inserted media card during the boot process.

Solving Display Problems
If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Table 7-5  Solving Display Problems

Blank screen (no video).

Cause Solution

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and, if set, type your
password.

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Blank screen and the power LED flashes red five times, once every second, followed by a two second pause, and
the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Blank screen and the power LED flashes red six times, once every second, followed by a two second pause, and the
computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes red seven times, once every second, followed by a two second pause, and
the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause Solution

The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.

Cables are not properly connected. Check that the graphics cable is securely connected to the
graphics card and the monitor.

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.
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The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them
apart.

2. Fluorescent lights or fans may be too close to the
monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.

“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what
the monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so
that the new settings take effect.

High pitched noise coming from inside monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Monitor’s internal digital conversion circuits may be unable to
correctly interpret the output synchronization of the graphics
card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that
will assist you with the synchronization, go to the
following Web site, select the appropriate monitor, and
download either SP32347 or SP32202:
http://www.hp.com/support

Graphics card is not seated properly or is bad. 1. Reseat the graphics card.

2. Replace the graphics card.
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Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. Click Start > All Programs > Accessories >
System Tools > Character Map. You can copy the symbol
from the Character Map into a document.

Solving Audio Problems
If the computer has audio features and you encounter audio problems, see the common causes and
solutions listed in the following table.

Table 7-6  Solving Audio Problems

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the
computer. The speakers should be plugged into the rear line-
out jack and the headphones should be plugged into the
front headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection.

Digital CD audio is not enabled. Enable digital CD audio. In the Device Manager, right-click
on the CD/DVD device and select Properties. Make sure
Enable digital CD audio for this CD-ROM device is
checked.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.
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Table 7-6  Solving Audio Problems (continued)

Sound does not come out of the speaker or headphones.

Cause Solution

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on
the hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.

There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.
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Table 7-6  Solving Audio Problems (continued)

There is no sound or sound volume is too low.

Cause Solution

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving Printer Problems
If you encounter printer problems, see the documentation that came with the printer and to the
common causes and solutions listed in the following table.

Table 7-7  Solving Printer Problems

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not
installed.

1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and
electrical outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it
back on.
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Printer is offline.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty. Select online.

Solving Keyboard and Mouse Problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table 7-8  Solving Keyboard Problems

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. 1. Click Start, click the arrow on the lower right corner of
the Start menu, then select Shut Down.

2. After the shutdown is complete, reconnect the keyboard
to the back of the computer and restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.
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Table 7-9  Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then
press the Enter key.

3. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/
keyboard, or no function of mouse/keyboard and external drive.

Cause Solution

If your computer is equipped with USB 3.0 ports, connected
USB 3.0 devices can interfere with the wireless keyboard
USB receiver.

Connect the wireless keyboard USB receiver to a USB 2.0
port that is separated from ports with USB 3.0 devices. If you
still experience interference, you may have to place the
connectors farther apart using an external USB hub.
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non–plug and play device, you must reconfigure
the computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table 7-10  Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected
and that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn
on the computer to integrate the device with the computer
system.

When the system advised you of changes to the
configuration, you did not accept them.

Reboot the computer and follow the instructions for
accepting the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.

Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed.
DIMM1 must be installed before DIMM2, and DIMM3
must be installed before DIMM4.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for
specific problems.

3. If you still cannot resolve the issue, contact Customer
Support.
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Power LED flashes red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM1 or XMM1 must always be installed.
DIMM1 must be installed before DIMM2, and DIMM3
must be installed before DIMM4

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Graphics card is not seated properly or is bad, or system
board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Power LED flashes red ten times, once every second, followed by a two second pause, and the computer beeps ten
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1. Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see
if fault goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.

Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.
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Table 7-11  Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management > S5
Maximum Power Saving.

S5 Wake on LAN is disabled. : Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on LAN.

Wake-on-LAN is not enabled. 1. Select Start > Control Panel.

2. Under Network and Internet, select View network
status and tasks.

3. Click Local Area Connection.

4. Click the Properties button.

5. Click the Configure button.

6. Click the Power Management tab, then select the
check box to Allow this device to wake the computer.

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Incorrect network driver. Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into
the correct operating mode.
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Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other
end of the cable.

Ensure that the cable and device at the other end are
operating correctly.

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective. Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network icon in the Control Panel and configure
the network controller.

Network controller stopped working when an expansion board was added to the computer.

Cause Solution

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers, using the Recovery Disc Set
created from the hard drive's Recovery Partition.

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.
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New network card will not boot.

Cause Solution

New network card may be defective or may not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving Memory Problems
If you encounter memory problems, some common causes and solutions are listed in the following
table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending
on the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you
must unplug the computer power cord before attempting to reseat, install, or remove a DIMM module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC
memory. Otherwise, the computer will not boot the operating system.

Table 7-12  Solving Memory Problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the DIMM1 or XMM1
socket.

Ensure that a memory module is installed in the DIMM1 or
XMM1 socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for
the system or the new memory module is not seated
properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.
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Out of memory error.

Cause Solution

Memory configuration may not be set up correctly. Use the Device Manager to check memory configuration.

You have run out of memory to run the application. Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed
correctly and that proper modules are used.

Integrated graphics may use system memory. No action required.

Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs)
are installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving Processor Problems
If you encounter processor problems, common causes and solutions are listed in the following table.

106 Chapter 7   Troubleshooting Without Diagnostics



Table 7-13  Solving Processor Problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously
enabled on this system.

1. Install a TXT capable processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.

Solving CD-ROM and DVD Problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

Table 7-14  Solving CD-ROM and DVD Problems

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Server Mode is enabled in Computer Setup. Run the Computer Setup utility and disable Network Server
Mode in Security > Password Options.

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.
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Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 101 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray
out from the drive until the tray is fully extended, then remove
the disc.
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CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Solving USB Flash Drive Problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

Table 7-15  Solving USB Flash Drive Problems

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure that “Device
available” is selected for “Front USB Ports” and “Rear USB
Ports” under Security > Device Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system
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System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.

Solving Internet Access Problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Table 7-16  Solving Internet Access Problems

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up
properly.

Verify Internet settings or contact your ISP for assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem
and the computers’s RJ-45 connector. (If the connection is
good, the “PC” LED light on the front of the cable/DSL
modem will be on.)
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Table 7-16  Solving Internet Access Problems (continued)

Unable to connect to the Internet.

Cause Solution

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser
remember some specific information that the Web server can
later retrieve.)

1. Select Start > Control Panel.

2. Click Network and Internet.

3. Click Internet Options.

4. In the Browsing history section on the General tab,
click the Delete button.

5. Select the Cookies check box and click the Delete
button.

Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.

Internet takes too long to download Web sites.

Cause Solution

Modem is not set up properly. Verify that the modem is connected and communicating
properly.

1. Select Start > Control Panel.

2. Click on Hardware and Sound.

3. Click on Device Manager.

4. Double-click Modems.

5. Double-click Agere Systems PCI-SV92PP Soft
Modem.

6. On the General tab, click Diagnostics.

7. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.
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Solving Software Problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Table 7-17  Solving Software Problems

Computer will not continue and no HP logo screen has appeared.

Cause Solution

POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST Error Messages
on page 113 to determine possible causes.

See the Restore Kit or the Worldwide Limited Warranty for
terms and conditions.

Computer will not continue after HP logo screen has appeared.

Cause Solution

System files may be damaged. Use recovery diskette to scan hard drive for errors.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your
version of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.
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8 POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the
probable source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count
and non-error text messages. If a POST error occurs, the screen will display the error message. To
manually switch to the POST Messages Enabled mode during POST, press any key (except F10,
F11, or F12). The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.
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POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section
also includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table 8-1  Numeric Codes and Text Messages

Control panel message Description Recommended action

ERROR: No boot disk has been detected or
the disk has failed.

The computer cannot read the boot sector
of the boot disk.

1. Check drive data and power cables.

2. Use F10 Setup to make sure the first
boot device is set to drive C or the
primary hard drive.

3. The drive has failed due to mechanical
or virus corruption. Replace the drive.

Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

5. Replace the system board.

511-CPU Fan not Detected CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System
test under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

Unsupported CPU Recently installed processor is not
supported by the system.

Install a processor supported by your
system.

Time & Date Not Set Invalid time or date in configuration
memory.

RTC (real-time clock) battery may need to
be replaced.

CMOS jumper may not be properly
installed.

Reset the date and time under Control
Panel (Computer Setup can also be used).
If the problem persists, replace the RTC
battery.

Check for proper placement of the CMOS
jumper if applicable.
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Interpreting POST Diagnostic Front Panel LEDs
This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of
the computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be
performed.

Not all diagnostic lights and audible codes are available on all models.

Table 8-2  Diagnostic Front Panel LEDs and Audible Codes

Activity Blink
s

Possible Cause Recommended Action

White Power LED flashes
five times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the DIMMs or the
system board, you must unplug the computer power
cord before attempting to reseat, install, or remove a
DIMM module.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

White Power LED flashes
six times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

6 Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the
system board.

White Power LED flashes
seven times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

7 System board failure (ROM
detected failure prior to
video).

Replace the system board.

White Power LED flashes
eight times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

8 Invalid ROM based on bad
checksum.

1. Reflash the system ROM with the latest BIOS
image.

2. Replace the system board.
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9 Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer
Setup Utilities menu: setup password and power-on password. When you establish only a setup
password, any user can access all the information on the computer except Computer Setup. When
you establish only a power-on password, the power-on password is required to access Computer
Setup and any other information on the computer. When you establish both passwords, only the
setup password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to
the information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See Computer Setup (F10) Utility on page 9 for information.
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Establishing a Setup or Power-on Password
To establish the power-on or setup password features, complete the following steps:

1. Turn on or restart the computer.

2. As soon as the computer turns on, press the Esc key while “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

3. Press the F10 key to enter Computer Setup.

4. To establish Setup password, select Security > Setup Password and follow the instructions.

– or –

To establish a Power-On password, select Security > Power-On Password and follow the
instructions on the screen

5. Before exiting, click File > Save Changes and Exit.
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Resetting the Setup and Power-on Password
To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Regulatory, Safety and Environmental Notices guide
for more information.

3. Remove the access panel.

4. Locate the header and jumper labeled PW.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service
Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper.

6. Replace the jumper.

7. Replace the access panel.

8. Reconnect the external equipment.

9. Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

10. Establish the new passwords in Computer Setup. See Computer Setup (F10) Utility on page 9
for information.
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Resetting CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

CAUTION: Removing and replacing the CMOS jumper will reset CMOS values to factory defaults. It
is important to back up the computer CMOS settings before resetting them in case they are needed
later. Back up is easily done through Computer Setup. See Computer Setup (F10) Utility on page 9
for information.

To reset CMOS, complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Regulatory, Safety and Environmental Notices guide
for more information.

3. Remove the access panel.

4. Locate the header and jumper labeled CMOS.

NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service
Map (IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5. Remove the jumper and place it on pins 1 and 2.

6. Wait for three seconds, and then replace the jumper to its original position (pins 2 and 3).

7. Replace the access panel.

8. Reconnect the external equipment.

9. Plug in the computer and turn on power. Allow the operating system to start.

NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that
configuration changes have occurred. Use Computer Setup to reset any special system setups along
with the date and time.
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A Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts
AC. Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General Requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.

Country-Specific Requirements 121



B Specifications

All-in One Models
Table B-1  Specifications

Desktop Dimensions

Height

Width

Depth

16.00 in

20.00 in

8.66 in

40.6 cm

50.7 cm

22.0 cm

Approximate Weight

With stand

Without stand

15.36 lb

12.63 lb

6.97 kg

5.73 kg

Display

Type

Viewable image area

Resolution

Contrast ratio

Image brightness

Viewing angle (typical)

Pixel pitch

Backlight lamp life (to half brightness)

Color gamut (typical)

Anti-glare

TN (Twisted Nematic) LED Backlit LCD

442.8(H) x 249.075(V) [mm]

1600x900

1000:1 (typical)

250 nits (typical)

85°/85°/80°/80° (L/R/U/D)

0.27675(H) x 0.27675(W) [mm]

30,000 hours minimum

72%

Yes

Temperature Range

Operating

Nonoperating

41° to 95°F

-22° to 149°F

5° to 35°C

-30° to 65°C

Relative Humidity (noncondensing)

Operating 15-80% at 79°F 15-80% at 26°C
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Table B-1  Specifications (continued)

Maximum Altitude (unpressurized)

Operating

Nonoperating

0 - 6,500 ft

0 - 15,000 ft

0 - 2000 m

4,572 m

Power Supply

Rated Voltage Range

Rated Line Frequency

100-240 V

50-60 Hz

Max Operating Power 150 W
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